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The following icons are used in this user manual:

o e

The information icon precedes important information.
& | The example icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

/¥ | The warning icon provides a warning against potential mistakes and actions that
could cause critical error.
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Congratulations on choosing Attix5 Pro Desktop & Laptop Edition. Attix5 Pro minimises risk,
maximises productivity and allows businesses to regain control of their most valuable asset -
their data.

For technical support, please go to Help > About Attix5 Pro , and then use the contact details
provided.

With Attix5 Pro Desktop & Laptop Edition (DL), data stored on desktop and laptop computers
can be backed up to a Storage Platform quickly, securely and automatically.

The following diagram illustrates the scenario:

Storage Platform Files and folders stored on desktop or laptop
computers running Attix5 Pro DL can be
backed up to a Storage Platform. In the event
of data loss or corruption, you can retrieve
data from the Storage Platform and restore it
to the original or another computer in just a

few easy steps.

A Backup Administrator can manage the entire backup environment (DL Clients and the
Storage Platform) remotely, using the Attix5 Pro Storage Platform Console. For more
information, please refer to the Attix5 Pro Storage Platform Console User Manual
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1. Getting started

Enabling manual or automatic backups is easy with Attix5 Pro Desktop & Laptop Edition:

| ) o

BACK UP
Automaticallyor
ERE)Y

Create a Backup Select files and
ystall DL Account folders for backup

(See page 11) (See page 36) (See pages 4547)

(See page 7)
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Below are the system requirements for Attix5 Pro Desktop & Laptop Edition.

i) For the latest system requirements and compatibility information, please refer to
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pro
software).

Attixs5 Pro DL is available for the following Microsoft operating systems:
Windows 7
Windows Vista
Windows XP (SP2)

Required: Pentium III [32-bit (x86) or 64-bit (x64)] processor with 128 MB memory
dedicated to Attix5 Pro above the operating system requirements.

Recommend ed memory : 256 MB dedicated to Attix5 Pro above operating system
requirements.

Required : 50 MB plus space for local cache.

i) Please ensure that the drive on which the Backup Client will be installed has
enough free space to store copies of the selected files.

Recommended: Amount of free space equal to the Backup Account limit. The local
cache can be as large as the total size of all files included in the backup selection.

= A 100 MB inclusion may require up to 100 MB free space for the cache.

Minimum video requirements: 800 x 600 Resolution, 256 colours
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The DL MSI file contains pre-configured information to make installing DL quick and easy. For
more information on creating MSI files and launching them from the Run Command, please
refer to the Attix5 Pro Storage Platform Console User Manual

i The options available during the installation process depend on the settings
enabled by the administrator when the MSI file was created. These options range from
advanced install settings to specifying the install location. The default install path is:
C:\ Program Files \ Attix5 Pro

v\ | Pre-installationw  arning s:

A If running antivirus software, please ensure that all Attix5 Pro folders are excluded
from being scanned to avoid data corruption.

A Both antivirus software scans and backup processes are resource-intensive. It is
advised not to run a backup and virus scan at the same time as this will
significantly decrease machine performance.

A Please ensure that you run the MSI file suited to the installed operating system (i.e.
32-bit or 64-bit). The filename should indicate the target platform. If unsure,
please contact your Backup Administrator.

To install Attix5 Pro DL:

1.  Run the MST file.
2. In the Attix5 Pro DL Setup Wizard that appears, follow the steps as described in the
following section.
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Attix5 Pro DL Setup Wizard

The Attix5 Pro DL Setup Wizard typically consists of four steps to guide you through the Setup
task in a simple, step-by-step manner. These steps also make it possible to undo previous
operations by navigating backward.

i) | Note: Some of the settings encountered in the wizard may have been removed when the
MSI was created. Furthermore, the wizard may contain additional steps. Please read
each window carefully before continuing.

Step 1 of 4: Start the Setup Wizard

To start the Setup Wizard: 1) i Pro DL Setup == ==

Click Next . Welcome to the AttixS Pro DL Setup
Wizard

The Setup Wizard will install AttixS Pro DL on your computer,
Click Mext to continue or Cancel to exit the Setup ‘Wizard,

/

ATTIX®Pro

Step 2 of 4: Specify an install location

To specify a destination for the DL 15! 84435 Pro DL Setup ==
application files and folders: Pestination Folder - Ur_@

Click Mext to install ko the default Folder or click Change to choose anather,

Click Next to accept the default
destination folder and continue to

Install AttixS Pro DL to:

the neXt WiZard Step~ ‘C:\Program FilesiattixS ProjBackup Client DLY
Alternatively, specify a new

destination folder:
1. Click the Change button.
2. Browse to the folder in
which to store the

Back. ][ Mext J [ Cancel

application files.

3. Click OK.

4. Click Next to continue to
the next wizard step.
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Step 3 of 4: Begin the installation

ATTIX’

Once all the settings are configured, the wizard is ready to begin the installation.

To begin the DL installation:
Click Install .

1] At Pro DL Setup

Ready to install Attix5s Pro DL E @

Click. Install to begin the installation. Click Back to review or change any of yvour
installation settings, Click Cancel to exit the wizard,

Back ][ ‘?:;'Insta\l ] [ Cancel

Step 4 of 4: Exit the Setup Wizard

The last step of the wizard presents the option to launch the Backup Client.

To launch the Backup Client
immediately after the Setup
Wizard:

1. Ensure that the Launch Attix5
Pro DL check box is selected.
2. Click Finish .

After clicking Finish , Attix5 Pro DL will
be installed on the machine. If the
Launch Attix5 Pro DL check box was
selected as described above, the Backup
Client will open automatically and the
Backup Account Setup Wizard

the wizard steps as described i n

) AttixS Pro DL Setup

y

ATTIN?Pro

=l @ m=

Completed the AttixS Pro DL Setup
Wizard

Click the Finish button ko exit the Setup Wizard,

Launch Backup Client DL

AAccount

will launch, enabling you to create a Backup Account. Follow
Chapter 3,

setup. o
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To back up or restore data using the Backup Client, a Backup Account is required.

If you selected the Launch Attix5 Pro DL check box in the last step of the Setup Wizard (see
The Attix5 Pro DL Setup Wizard in Chapter 2, fi | ns t)athelBackup Gliend will run and
display the Backup Account Wizard automatically. Use this wizard to set up a Backup Account
by following the steps as described below.

If the Launch Attix5 Pro DL check box was not selected in the last step of the Setup Wizard,
the Account Setup Wizard will launch when the Backup Client is opened for the first time (for

more information, see Opening the Backup Clienti n Chapter 4, #AGraphical User
i) To run the Account Setup Wizard at any other time: On the Tools menu, click
Account Setup Wizard . In the warning box that appears, click the Run Account

Setup Wizard button and follow the instructions below from Step 2 onwards.
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The Account Setup Wizard typically consists of seven steps to guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previous operations

by navigating backward.

i) Some of the settings encountered in the wizard may have been removed when the
MSI was created. Furthermore, the wizard may contain additional steps. Please read

each window carefully before continuing.

i) This step displays when the wizard is run directly after the DL Client installation.
If accessing the wizard at a later stage (via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform
connection settings:

1. In the Storage Platform
address box, type the IP address
or DNS name of the Storage
Platform where the Backup
Account resides.

2. In the Group name field, specify
which Backup Group the Account
belongs to.

3. In the Group create key field,
specify the preconfigured Group

ing:
¥ I you do not have the required information.

Storage Platform Settings

Storage Platform address: |192,168.20,215

Group create key:

E=
tings. [ i@

A-5P OWNER|RESELLER MBACKLP ACCOLNTS

Help <Back o> | [ cancel

create key for the applicable Group. If you do not have access to this key, please contact

your Storage Platform administrator.
i) This key is case sensitive.

4. Once all the correct settings have
been entered, click Next .
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This wizard step is typically the first to be displayed if you access the wizard via

the Tools menu.

You can select | want to connect to an existing Backup Account to:
Connect to an Account that has been opened for use by this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.

To create a new Backup Account: =
5 NEw oF xisting Backup Account. You cannot connect to the same Backup Accourt from @
1. Select | want to create a new - EE-T
BaC ku p ACCO unt . Please select ane of the Following:
@ {iyank fo creefs 2 new Hatkip Account:
2 . Click N EXt . “ I'want to connect to an existing Backup Account.

To connect to an existing account:

1. Select | want to connect to an
existing Backup Account

/0 | Warning:  Different users
cannot back up to the same
Backup Account. A separate
Backup Account needs to be
created for each user.

ATTCPro

Help <gack | [Cmes> | [ cancel

2. Click Next to continue.
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When connecting to an existing ot SupWasrd %
Enter the existing account details.
Acco u nt: Supply the Backup Account details that you want ko recomnect to, ( Lf‘_f
Account Details
1. In the Backup Account name e e

Pinimum 4 characters

box, type the Account name. g |
2. In the Account password box,
type the Backup  Account
password.
3. In the Encryption key  box, type
the encryption key chosen when

Viinirum 8 charackers

the Backup Account was created. ATTIXSero
i (<t ] [t ) Lo |
To specify the new Account details:

1. In the Backup Account name ———— %
bOX, type an Account name that Chuusearvdenteryuuvpreferredac(uun:name,passwnrdanden(vyptmnk&y. [L":
consists of a minimum of 4 e et S A
characters. e

2. In the Account password box, f{.?iiiilffiisli??gﬁ‘;llﬁéﬁEli'aw?ﬁT.'Sfé;"Q’:ZEi“ffé’l"ﬁ?ﬁ?ﬁ?é&?é@”&iﬁii’ﬁ?@ﬁ"?ié’”
type a password that consists of a kzh
minimum of 4 characters. Cofrmter:  [sneenene

3. In the Confirm password box,
repeat the Account password
entered in  the  Account B .
password box above. o] [ <me | [(te> ] [LGned |

4. In the Encryption key  box, type
an encryption key that consists of a minimum of 8 characters.
5. Click Next .

/0 | warning:  Disaster recovery is not possible without the encryption key. Please ensure
that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT STORED ON THE
STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF LOST.
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Step 4 of 7: Specify connection settings

To specify the connection settings: Cr——— %

Select the type of connection that you use to connect to the Internet. =

1. In the Connection Settings area,
select | use broadband or
another  permanent network
connection

2. Click the Configure Proxy
button.

3. In the Proxy Setup dialog box

Configure Proxy.

that appears, select a proxy type. £
4. If Use SOCKSvV5 Proxy or Use ATTIX®Pro

HTTP Proxy is selected, fill in the pichis) (sifie [t (Gl

Proxy Host and Proxy Port

boxes.
5. Iflogin details are required, select the Proxy server requires authentication check
box and type the username and password in the boxes provided.
Click OK to close the Proxy Setup dialog box.
Click Next to move to the next step in the wizard.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



Attix5 Pro can run backups on included
files and folders either upon request
(manually) or automatically. This step
enables you to set up a backup schedule.

It is advised to back up at
night when the machine is running
and the Backup Client is not in use.
The machine must be switched on

at the time(s) specified for
scheduled  backups, but the
Windows user does not need to be
logged in.

To configure the Backup Client to
run only manual backups:

1. Clear the Daily au tomatic backups

ATTIX’

[Ed] Account Setup Wizard (=)
Do you want ta schedule automated backups? @
Specify the daily and hourly backup schedule. You are strongly recommended to enable automatic backups. (!C:
ki
Backu svery day ats = _19n0n | ()
[ Advanced schedue
Back up at the following times
Week Day Additional Schedule
Mu”d;‘/ Backup time:
Tuesday o
wedhesday Hoo 1@
Thursday add
Friday
Saturday Delete
Sunday
AaTTI®Pro
b | [ <Back | [ mext> |[ cancal |

2. Click Next to move to the next step in the wizard.

v | Warning:

This option is not recommended. If an automated backup schedule is not

created, backups will have to be run manually. Enabling automatic backups is

strongly advised.

To schedule daily automatic backups:

1. Select the Daily automatic backups
In the Back up every day at

check box.

box, specify a backup time.

Click Next to move to the next step in the wizard or schedule additional advanced

backups as described below.

To schedule advanced backups:
Select the Advanced Schedule

o H W hd e

Schedule box.

check box.
In the Week Day area, select a day on which a backup should be initiated.
Specify the time in the Backup time  box.
Click the Add button to add the day and time to the Additional Schedule
Repeat the steps above until you have added all desired schedules to the Additional

6. Click Next to move to the next step in the wizard.

box.
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Under normal circumstances, the default e — =
0 you want te modify the default working folders?
Te m p ’ C aC h e 3 LO g S and D atab ase ” E;:;;;iéz;’; aﬁgfz? tlhueg,d;:;ntmv;’r: [ﬁ};; mdé;v;ﬂiiﬁ;:g;;tabase to another location if there is ( L:‘_’@
folder locations can be accepted and you i
Note: Always keep these folders on the same drive/volume,
can CliCk N ext Without making any Temp :{Program Files\AttixS ProlBackup Client DLytoBackup E=ES
. . . Cache: C:\Program Files\AttixS Pro\Backup Client Dlicache Browse.
modifications. If, however, the drive on i [Coganrispiospelbatap e Dlios
Database: C:\Program Files\AttixS Pro{Backup Client DL Browse.

which the Backup Client is installed has
limited space available, you can move the
folders and selection database to another
location.

ATTINPro

t. | Warning:  Please ensure that these
folders are located on a drive with
sufficient free space.

b | [ <Back | [THext> | [ cancal |

To change the temp, cache, logs and/or database folder locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a
different location for that folder.

2. Repeat step 1 above until all folder locations are correctly specified. Click Next to
continue with the installation process.

/v, | Warning:  The Cache and Temp folders must reside on the same drive/volume.
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In the final step of the Account Setup Wizard, a Summary screen displays a list of the configured
settings.

To confirm the Setup information: B %
1. Read and wverify that the s

If the settings below are correct then dick Next, otherwise click Back to change your settings,
information is correct, and then
Attix5 Pro Username: BACKUP ACCOUNT 01
l- k Connection method:  Local Area Network
click Next . P ——

Backup daify t:  19h00

Summary

Wou have entered the following information:

2. The Backup Client will connect to
the Storage Platform and configure
the Backup Account. A message
will be displayed to confirm that
the Account was set up
successfully. AaTTGEN0

3. Click OK to close the message box. o ] <ot LEREE]( ceed

The Setup Wizard Completed screen will confirm the Account creation (or connection if
connecting to an existing Account).

lE‘ Account Setup Wizard @

Setup Wizard Completed
The next step is to configure the backup selection lisk. You can include Files, folders and use selection filkers.

Refer to the Backup Client Help section for [ | @

further information.

Your account has bheen created successfully.

Group: A-5P OWNERNRESELLER ANBACKUP ACCOUNTS
Username: BACKUP ACCOUNT 01

Account size: 1024 MB

¥ou may now proceed to select files and folders for backup.

ATTIX Pro

Now that a Backup Account has been configured/you have connected to an Account on the
Storage Platform, you can select the files and folders you wish to back up.
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups
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Opening the Backup Client interface

To open the DL Client interface:

On the Start menu, point to All Programs , point to Attix5 Pro , and then click Backup
Client DL.

@ Default Programs

W Desktop Gadget Gallery

& Internet Explorer

) Windaws DVD Maker

E58) Windowes Fax and Scan Bashierah

 vindows Media Center

@ Windows Media Player

E'_| Windows Update

o ¥PE Wiewer

L. Accessories

Lo Agtixh Pro

 [B] Backup Client DL, Games
|, Storage Platforr

Documents

Pictures

luisic

. Garnes Computer

, Maintenance
J Microsoft Office Control Panel
| Startup
Dewvices and Printers

Default Pragrarms

Help and Support
4 Back Win urity

| Search progrors and files m

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Alternatively, double-click the Attix5 Pro icon in the system tray or right-click the icon and then
click Open :

Open

Backup Mo

Cancel Backup
Monitor Status
Motifications r
Shout

Exit 7
 — .
CRox e 1/8/2010 |

i) | Note: The first time you open the Backup Client, the Account Setup Wizard launches by default.

For more information on creating a Backup Account,seeChapt er 3, fiAccoun

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



The Client interface explained
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You can manage and monitor backups using the Backup Client application window, the system
tray icon or the notification bubbles that appear when certain processes occur. Below are

descriptions of each of these items and the options they provide.

Application window

The Backup Client application window contains the following areas:

[Ea] 2ttiss Prov.0.0

<d—

File Selection Tooks Yiew Help <

Menu bar

AT S N

@

Program Files
ProgramData

Recovery

System Yelume Information
Users

= windows

Recovery

System Yolume Information
Users.
dows
autoexec.bat
config.sys
hiberfl sys
pagefile. sy

Backup Size Restore  Find Options ~ Automate A"
& Backup Selection | ) Restore | =] Logs| N\
i My Computer i Filename Size [ pate
L My documerts $Recycle.Bin 2010-01-20 ...
B& MSOCache 2009-11-12 ...
$Recycle.Bin PerfLogs 2008-07-14 ...
MSOCache Program Files 2010-01-16 ...
Perflogs ProgramData

2009-11-20 ...

2010-01-20 ...
2010-01-20 ..
2009-12-12 ..

LKE 2009-06-10 ...

LKE 2009-06-10 ...
1,965,736 KB 1970-01-01 ...
2,620,984 KB 1970-01-01 ...

Re S

cady

N &4 Product Help

ou can tell the Backup Client which fles andfor

Felders to back up and which ta ignore by clikiy
the & Backup Sel i then including
n & tems as described belon.

Tip: Cnce a file or folder is included in the backup
selection, any modifications to it wil be backed up
automatically

How to..

Include an individual file
Include an entire folder
Exclude a file ar subfolder
Caleulate the backup selection size

To include an individual file:

1n the Backup Sele Tee, navigate to the folder
or directoryserfaining the file, In the right-hand

k. the file iean () or right-rlick the file
ame and then click Include, An indluded il is
displayed with s green lcon; ©,

To deselect & fie, you can sither dick the ican sgsin
or right-click the file name and then click Deselect.
i Folder containing same included Files is displayed
with 5 green binted icon: £,

Toinclude an entire folder:

Right-click the Folder icon (L~ ) and then dick.
Include Folder, Alternatively, you can select the:
felder in the Backup Selection tree, and then dlick
Include Folder on the Selection menu. Included
Felders are displayed with & areen izon: £

Note: Al files in the included folder and its
subfolders will be included in the next backup, Any

w |

Toolbar

| —— Tabs

/ Product Help

/ | / Status bar

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Menu bar and toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most
commonly used menu bar functions are also available on the toolbar and right-click menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables below describe the
options available.

Backup Initiate a Backup immediately. @
Now —]

Backup
Restore Switch to the Restore view in the Client.

Q Tip: For faster access to the Restore view, click ;-t.: B
the Restore tab instead of using the File menu. Restore

Calculate Determine the total size of the data included in the backup r@

Size selection. For more information, see Determining the
L . Si
backup selectionsizei n Chapter 5, fABac¢ e
Find Access the Find Files in Backups  dialog box. This box e
Files in enables you to search for particular files in your backups. r@
Backups For more information, see Finding files in backups in Find
Chapter 6, fNRestores. o
Export Export a list of all backup inclusions and exclusions to an Selection Tools Help
Selection html file for future reference. For more information, see Backup Mow
Exporting a selectionreporti n Chapter 5, Reskore

Calculate Size

Find Files in Backups
Export Selection

Exit

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.



File menu continued...

ATTIX’

Exit

Close the DL Client application window.

\a> Tip: You can re-open the Client window at any
time via the Windows Start menu or by double-

clicking the icon in the system tray.

Selection menu

x il

Filters >

New Filter

Filters >
Edit
Filters

Create a new filter to
automate inclusions or
exclusions based on file
type. For more
information, see Using
Filters in Chapter 5,
fiBackups. o

Edit existing filters. For
more information, see
Using Filters in Chapter 5,
AiBackups. o

ISeIectiDn Tools Help

Filkers Mew Filker ...
Include Folder Edit Filters ...
Exclude Fald
HElEE o ) traphics 3
Deselect Folder 1 M3 Access databases »
Refresh 1 M3 Office documents
Bires 5 1 M3 Qutlook email 3
T ‘Web pages 3
ISeIectiDn Tools Help
Filkers 3 Mew Filker ...
Include Folder Edit Filters ...
Exclude Fald
HElEE o ) draphics 3
Deselect Folder 1 M5 Access databases
Refresh 1 M3 Office documents
SirEs s T M35 Qutlook email 3
) web pages 3

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Selection menu continued...

Filters >
[filter ]>

Include

Filters >
[filter ]>
Exclude

Filters >
[filter ]>
Deselect

Include all

files in the
selected folder
that match the
filter6¢
criteria. For
more
information,
see Using
Filters in
Chapter 5,
fiBackup:

Exclude all

files in the
selected folder
that match the
filterd:
criteria. For
more
information,
see Using
Filters in
Chapter 5,
fBackup:

Clear the
selected folder
of any filters
currently
applied to it.
For more
information,
see Using
Filters in
Chapter 5,
iBackup:

ISeIectiDn Tools Help

Filkers Mew Filker ...
Include Folder Edit Filters ...
alr,
Exclude Fold ==
il ) tGraphics 4 Include
Deselect Folder !
1 M3 Access dakabases » Exclude
Rafresh 1 M3 Office documents  » Deselact
Bires P 1 M3 Qutlaak email 3 FREIEE
T ‘Web pages »
ISeIectiDn Tools Help
Filkers 3 Mew Filker ...
Include Folder Edit Filters ...
alr,
Exclude Fald e+
eee Foer ) Graphics r Include
Deselect Folder !
1 M3 Access dakabases » Exclude
Refresh 1 M3 Office documents  » ——
SIrEs M T M35 Outlook email 3 EEE
) web pages 2
ISeIectiDn Tools Help
Filkers 3 Mew Filker ...
Include Folder Edit Filters ...
n|n
Exclude Folder . o
& Graphics P Incude
Deselect Folder !
1 M3 Access dakabases » Exclude
Refresh 1 M3 Office documents  » ——
SirEs M T M35 Outlook email 3 SSEIEC
) web pages 2
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Selection menu continued...

Include Folder

Exclude Folder

Deselect Folder

Refresh

Include the selected folder for backup.

Exclude the selected folder from the backup

selection.

Clear the selected folder of any inclusions or

exclusions.

Refresh the selection being displayed.

ISEIectiDn Tools Help

Filkers
Include Falder
Exclude Faolder

Deselect Folder

Refresh

F5

ISeIectiDn Tools Help

Filkers
Include Faolder
Exclude Falder

Deselect Folder

Refresh

F5

ISeIectiDn Tools Help

Filkers
Include Folder
Exclude Falder

Deselect Folder

Refresh

F5

ISeIectiDn Tools Help

Filkers
Include Folder
Exclude Falder

Deselect Folder

Refresh

F5
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Tools menu

Automatic

Backups

Account
Setup
Wizard

Remote

Management

Health
Check

Access the Backup Schedule settings in the Options
and Settings dialog box. Configure the settings in
the Automatic Backups area to set up one or more
automatic backups. For more information, see
Scheduling automatic backups in Chapter 5,
fiBackups. o

Launch the Account Setup Wizard, which enables you
to change the Backup Account settings. For more
information, see Account Setup Wizard in Chapter 3,

ifiAccount setup. o

Access the Remote Management Settings dialog
box. Using the settings available, you can enable
Remote Management of the Client via the SP
Console. For more information, see Remote

Managementi n Chapter 8,

Access the Health Check dialog box. Performing a
Health Check enables you to highlight possible
issues. For more information, see Health Check in

Chapter 8, fAOptions and

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.

[Tu:u:uls Wiew Help

Automatic Backups
Account Setup Wizard

Remate Management
Health Check. .
Snapshok

Options

[Tu:u:uls Wiew Help

Automatic Backups
Account Setup \Wizard

Rernoke Managermenkt
Health Check. ..
Snapshok

Options

[Tu:u:uls Wiew  Help

AOpti

Automatic Backups
Account Setup Wizard

Remote Management
Health Check. ..
Snapshok

Options

[Tn:n:nls Wiew Help

Autoratic Backups
Account Setup Wizard

Femote Management
Health Check, .,
Snapshot

Options
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Tools menu continued...

m Click the option to... Menu/Button

Snapshot Access the Export Backup Snapshot  dialog box, 3 Expott Backup Snapshat
> Export which enables you to configure the next backup to be | Import Restare Snapshok
Backup a Snapshot backup to a specific location. For more
Snapshot information, see Backup Snapshots in Chapter 8,

iOptions and Settings. o
Snapshot Access the Import Backup Snapshot  dialog box, hl Export Backup Snapshat:
> Import which enables you to configure Restore Snapshot | Impart Restare Snapshat
Restore settings. For more information, see Restore

Snapshot Snapshotsi n Chapter 8 SefiOpnice

Options Opens the Options and Settings  dialog box that

enables you to modify a range of Client settings. For
Cphions
more information,s ee Chapter 8,

Settings. o

Option Click the option to... Menu/Button
Language > Access the GUI language options iew | Help .
[ English/German/Default ] available. Language # English
EErman
@  Defaul

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved. m
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Click the option

Menu/Button

Icon
Legend

Product
Help

About
Attix5 Pro

to...

Access a list of the icons
used in the Attix5 Pro
Client and the statuses
they indicate.

Access the Product
Help.

Access the product
information and support
contact details.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.

Elp

Icon Legend

Produck Help
Abouk AbixS Pro SE

©

Help

Elp

Icon Legend 2

Product Help
about AktixS Pro

D20PDDO

File (naot selecked)
Included by user
Included by user Filker
Excluded by user
Exchuded by user filker
Exchuded by administrato
Included by profiling



Tabs

There are three tabs available in the Backup Client:

ATTIX’

Backup Selection:  This tab displays the files and folders on the computer, enabling

you to select the items to be backed up. For more information, see Selecting data to

backupi n Chapter 5,

iBackups. 0

Restore: Use this tab to browse previous backups and restore files and folders.

Logs: Use this tab to view detailed information on each backup and restore.

)

Tip: Inthe right-hand pane on the Backup Selection and Restore tabs, you can click

any of the column headings to sort the list according to their values.

i Backup Selection | ] Restore | B |=|:||;|5|

a Pse Compuker
L, Mip

Mf My documents
XY |
[}~ $Recycls.Bin
-4 MSOCache
-4 Perflogs
-4~ Program Files
-4 ProgramDats
L Recovery
--L_'. Swskem Volume Information
B0 Users
k) Windows

_ | Filzname
|~ $Recycle.Bin

|~ mMs0Cache

[~ PerfLogs

[~ Program Files

[~ ProgramData

[~ Recovery

|~ system Yolume Infarmation
=7 Users

[ windows

) autoexec.bat

T config.sys

0 hiberfil.sys

™ pagefile.sys
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Product Help

@ You can access the Backup Client Help by clicking Product Help  on the Help menu.

: Alternatively, click the Help button on the toolbar.
Help

As you navigate the Client, the Help pane will display information relevant to the selected tab.

@ Product Help @ Product Help
_ * _ *
2| |n| @ Re .y .
Quick-start B ‘fou can restore Files andfor Folders in
Skep-by-skep guide three steps:
Backups: How to... 1. Select data ko restore
Seleck data 2, Stark the restore process
Use selection filkers 3. gelect the restore options
Export a seleckion repork
Back up manually .
Select data b k
Schedule automatic backups electing data to restore
Rest  How ‘ou can kel the Backop Client which
EsLOres: How Lo... files and/or Folders to restore and
Restare files and Folders _ _ o ’
Find particular Files to restore which to ignore by clicking the |
Restore the backup seleckion Restore tab and then incuding ar
- excluding the ikems as described

Status bar

This area displays the date and time of the last backup performed by the system.

Ready Lask backup:Jan 18, 2010 2:55:31 PM

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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System tray icon

The System tray icon [E indicates the backup activity status and can be used to perform various

tasks.
o An animated icon indicates that the service is busy with a backup process.
Open
Right-click the system tray Backup Mow
icon to view the menu options Cancel Backup
available.

Q.:

Monitor Status
v Motify on Success Muatifications »
v Motify on Failures About
v Motify an Warnings

Bzt

Note: On the Windows 7 operating system, the system tray icon is hidden by default. To

display the icon, click the Show hidden icons arrow, click Customize . In the dialog
box that appears, expand the Behaviours drop-down next to A5Tray .exe, and then
select Show icon and notifications

System tray menu

Open

Backup Now

Cancel
Backup

Opens the Attix5 Pro Client application window.

Q Tip: Users can also double-click the system tray icon to open the
application window. For more info
earlier in this chapter.

Manually initiates the backup process without opening the Backup Client

application window.

If the service is busy with a backup (when the |E| icon is animated), Cancel will

stop the process.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Opens a small window

Backup Service [E]
a‘f)ove t?le system tray Attix5 Pro
displaying the progress Last Backup: Today 300 PM Success
of the current process. Mext Backup: Today 7:00 P

This enables you to

monitor the status and

progress of the task being performed without opening the application window.

Provides you with options to enable/disable backup notifications. For more

informati on, see

Displays a window containing the
product details. Click anywhere in the

window to close it.

AiNotificationso | ater
Bbout Atix5 Pro [

AltixS Prove,0.0
Copyright {c) AttixS 1999-2009

Product suppart cantact infarmation:
Debug Reseller v, akkixS. com
infof@attixS, com

Backup Account: BACKUP ACCOUNT 01
Backup Group:  A-SP OWNERIRESELLER A\BACKUP ACCOUNTS
Storage Platform: 192,168.20,215

Build: 682

User status: Registered

Plug-ins loaded:

- Discovery Plug-in version: 1.0,495

i ATTIX’Pro

Desktop & Laptop Edition V6.0

Removes the E] icon from the system tray.

e

backups.

This will not stop the Attix5 Pro service from running scheduled

To see the icon in the system tray again, simply open the Attix5 Pro Client interface

using the Windows Start b ut t on .

Client interfacebo

For more informatio
earlier in this chap
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1, | Warning:  The Backup Service must be running at all times for backups (manual or
scheduled) to take place.

i) To stop or start the Backup Service, open Administrative Tools in the Control
~ | Panel , and then double-click Services . In the list of services that appear, select Attix5
Pro DL and select Stop or Start on the toolbar. A red cross will appear in the corner

of the system try icon when the service is not running: .
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Notifications

The system tray icon can display a number of notifications once a backup has completed. The
following notifications are available:

Backup successful (popup message displayed for 5 seconds)

Backup successful with errors (message displayed for one minute)

Backup failed (message displayed until you click it)

When a notification is available, a pop-up will display information. If there were warnings or
errors, the system tray icon will also flash a red cross.

- M Attix5 Pro ? X
© Attix5 Pro X X Backup completed successfully but there were warnings
Backup completed successfully. and/or errors, please view backup log for more details.

i | Note: To view related log file information, click anywhere within the pop-up.

To disable notifications:

Notifications are enabled by default but you can disable them individually by right-clicking the
system tray icon and then clearing the check mark next to the relevant Notifications  option.

Open
Backup Mow
Cancel Backup

kdonitor Status

Motify on Success Motifications 2
v Maotify an Failures
v Motify on Warnings
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After installing Attix5 Pro Desktop & Laptop Edition (DL) and creating a Backup Account, you

can tell the Backup Client which files and/or folders to back up and which to ignore by creating a

backup selection ( s ee @ Sel ®dbdck unpgd dbacfbaccam)then start a backup manually

or schedule automatic backups ( see FfAPerfor maaogu@o mamd afiSdhedul i ng a
backupsodo bel ow) .

i) Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Select data to back up

Use filters to specify files and/or folders to be excluded from the backup selection.
Determine the backup selection size

Start backups (automatically and manually)

Cancel a backup

Resume a failed or cancelled backup

You can make your first backup selection or modify a backup selection at any time using the
Backup Selection  tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file
and/or folder(s).
3. Include or exclude the items as described below.

Once a file or folder is included in the backup selection, any modifications to it will
be backed up automatically. For more information, see PatchinginCh apt er 8,
and settings. o0

1, | Warning:  If you have limited space on the drive running the Backup Client, it is
recommended that you move the Cache , Logs and Temporary folders as well as the
selection database to another location. For more information, see Disk Usage in
Chapter 8, AOptions and Settings. o
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To include an individual file:

In the right-hand pane, click the file icon T or right-click the file name, and then click Include .
[

An included file is displayed with a green icon:

To deselect a file, you can either click the icon again or right-click the file name, and then

click Deselect . A folder containing some included files is displayed with a green tinted icon:
&

To include an entire folder:

Right-click the folder icon L-, and then click Include Folder . Alternatively, you can select the
folder in the Backup Selection tree, and then click Include Folder on the Selection menu.
Included folders are displayed with a green icon: L=,

i) All files in the included folder and its subfolders will be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder, right-click the folder icon, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click
the file or folder icon, and then click Exclude or Exclude Folder . Excluded items are
displayed with red icons: @ or ¥, Included folders that have some files or subfolders excluded
are green with a red tint: L=

You can use filters to automate file selection based on file types.

Once you have selected all files to be included and excluded, it may be useful to
check the size of your backup selection before initiating your first backup. For
more information, see Using Filters later in this chapter.

Some files and directories are forcefully excluded from the backup selection. On

Windows machines, these are the pagefile.sys and hiberfil.sys files; and the Backup
Client cache andto backup folders.

e
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You can use filters to automate file inclusions or exclusions within a folder, based on file types.

x A *.doc filter will include or exclude all Word documents within a folder, as
well as any new Word documents that are added to that folder later.

To apply a predefined filter to a specific folder:
In the Backup Selection tree, right-click the folder icon.
Point to Filters .

Point to one of the available filters in the list (e.g. MS Office documents ).
Click Include or Exclude .

B w pr

To modify an existing filter:
1. In the Backup Selection tree, right-click the folder icon, point to Filters , and then
click Edit filters

Select one of the filters and then modify its properties in the Edit filter  box.
Click OK .

To add a new filter from within the Edit filters  dialog box, click the New button, supply
a name that describes the filter, enter the file type(s), and then click OK .

To add a new filter via the Backup Selection tree:

Right-click the folder icon, and then click New filter

In the Filter name  box, type a name to be used in the Filters menu.

In the Filter box, specify the file extensions to which the filter will apply.
Click OK.

B wpF

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

Right-click the folder icon.

Point to Filters .

Point to the name of the filter you wish to remove.

Clear the check mark next to the selection (Include or Exclude ).

B w dr

To identify files and folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with
icons containing blue check marks: @ and £+,
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Some inclusions and exclusions are enforced at administration level on the Storage Platform.
This i s cal | K¥xdmofepdnfooniaiioh,iseePoofilingi n Chapter 8, AOption
Setting s . 0

Files and folders affected by profiling display with the following icons:

File inclusion
¥ Filtered file inclusion
File exclusion

Folder inclusion

o Filtered folder inclusion
x| Folder exclusion
i) Profiled selections cannot be modified from within the Backup Client and can only be

changed on the Storage Platform. For more information, please refer to the Attix5 Pro
Storage Platform Console User Manual
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Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon. The
colour of the icon indicates t h €Forfmorki@mformationfonl der 6 s
backup selections, sSeeel efict i ng d aearlierin this ¢haptek) u p 0

i Backup Selection | ol Restare I B Lu:n;s|

& My Computer ] Filename
L'..? Iy docurnents Cefault.rdp
=3 C deskbop.ini

-5 $Recycle.Bin
| MSOCache
L: PerflLogs
E_'E Program Files

salesDecz 009, kxk
salesJanz010.kxk
saleshoyv2009, bk

oY Y JoJo,

The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can
access this legend by clicking Icon Legend on the Help menu.

i) | Note: For more information, see Profiled selectionsi n Chapter 4, iGrap

(GUI) .o
Icon legend

C File (not selected) The file exists in the folder or directory but is not part of the

backup selection (neither included nor excluded).

[ = Selected by user The Backup Client user has included the file in the backup
selection.
fyr Selected by user filter The Backup Client user has applied a filter to the parent folder or

directory. That filter has included the file in the backup selection.

= Excluded by user The Backup Client user has excluded the file from being backed up
to the Storage Platform.
[ %} Excluded by administrator The Backup or Storage Platform Administrator has excluded this

file or its file type. Files displaying this icon will not be backed up
to the Storage Platform.

[ = Included by profiling The Backup or Storage Platform Administrator has included this
file or file type. Files displaying this icon will be backed up to the
Storage Platform and cannot be deselected from within the

Backup Client.
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Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files selected by user

All files selected by user

All files selected by user,

some excluded

All files excluded by the user

Filter applied by user

Filter applied by user, some

excluded

All files included by
profiling

Filter applied by profiling

Filter applied by profiling,

all items excluded

The Backup or Storage Platform Administrator has applied a filter
to the parent folder or directory. That filter has selected the file for
backup to the Storage Platform. Files displaying this icon cannot
be deselected from within the Backup Client.

The Backup or Storage Platform Administrator has excluded this
file or its file type. Files displaying this icon will not be backed up
to the Storage Platform and cannot be selected for backup from
within the Backup Client.

The folder exists but is not part of the backup selection (neither
included nor excluded).

The Backup Client user has included some of the folder6 s ¢ o n
in the backup selection.

The Backup Client user has included all of the folder6 s
the backup selection.

The folder contains no unselected files. The Backup Client user
has included some files and has also excluded one or more files.
The Backup Client user has excluded all files in the folder from
being backed up to the Storage Platform.

The Backup Client user has applied a filter to the folder. The filter

has included one or more files within the folder in the backup

selection.

The Backup Client user has applied a filter to the folder that has

included and excluded files within it.

The Backup Administrator has included all the files contained in
the folder. All files will be backed up to the Storage Platform.

These inclusions cannot be changed by the Backup Client user.

The Backup Administrator has applied a filter to the folder. This

filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to the folder,
resulting in the folder being excluded from the backup selection.

This filter cannot be removed by a Backup Client user.

Cc oim t ¢
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Filter applied by profiling, The Backup Administrator has applied a filter to this folder using
some items included by user  profiling and some items have been manually included by the

Backup Client user (see Selecting data to back up earlier in this

chapter).
Filter applied by profiling, The Backup Administrator has applied a filter to this folder using
some items included and profiling. Some items have been excluded and others included by
some items excluded by the Backup Client user (see Selecting data to back up earlier in
user. this chapter).
Filter applied by profiling Items in the folder have been included using filters (see Using
but items excluded by user. Filters earlier in this Chapter.)

Folder excluded by Global The folder has been excluded using Global Filters. For more

Filter. information, see Global Filtersi n Chapter 8, fO¢g
Settings. o

All files excluded by The Backup Administrator has excluded all files in the folder.

profiling These excluded files cannot be included by a Backup Client user.

Plug-in node (not selected) The plug-in exists but is not selected for backup to the Storage
Platform.

Some items selected by user ~ The Backup Client user has selected some of the items in the plug-

in for backup to the Storage Platform.

All items selected by user The Backup Client user has selected all items in the plug-in for

backup to the Storage Platform.

All items selected by user, The Backup Client user has selected all items in the plug-in for

some excluded backup to the Storage Platform but some items have been
excluded.

All items excluded by user The Backup Client user has excluded all items in the plug-in from

being backed up to the Storage Platform.

Filter applied by user The Backup Client user has applied a filter to the plug-in;
specifying that certain file types must be included for backup to
the Storage Platform.

Filter applied by user, some The Backup Client user has applied a filter to the plug-in;
excluded specifying that certain file types be included for backup to the
Storage Platform but some items have been excluded either

through the use of an exclusion filter or by manual exclusion.
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It is useful to determine the backup selection size before starting the backup process to avoid
Over Limit errors.

i) The Backup Client compares your backup selection size with the Backup Account

| limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceeds the Account limit, the backup process will stop and an Over
Limit error message will be displayed.

To calculate the backup selection size:

A. Onthe File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar:

EEEEEL

Backup Size Restors Find Options  Autamate Help

The Backup Selection  Size dialog box that appears displays total size of your backup
selection (i.e. all files included for backup).

Backup set index prepared in < 15
Files and directories: 1 Taokal size: 24 bytes
Mandatory files: 0 Tokal size; 0 bykes

/v | Warning:  If your backup selection size exceeds your Account limit, you need to remove
some items from the selection or ask your Backup Administrator to upgrade your
Account limit.

To remove a file from the backup selection:

A. In the Size dialog box, right-c | i ¢ k tidore ©fThd i@ will turn red to indicate
that it is excluded: &.
To exclude multiple files at once, click a file name in the list, hold down the

Shift key and drag the mouse pointer to highlight the files. Right-click the
selection, and then click Exclude .

B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are
currently selected for backup. For more information, see Selecting data to back up in
Chapter 5, fABackups. o
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Exporting a selection report

After creating a backup selection, you can export a list of all backup inclusions and exclusions to

an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How each item was selected (user-selected, filters, profiling or mandatory patching)
Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. On the File menu, click Export Selection
2. Inthe Save As dialog box that appears, select the location in which to save the file, type
a file name in the File name box, and then click Export

The file will be saved to the specified location and can be viewed in any Internet browser.

€ Colsers\UsertDocurnents\Backup selection.html - Windows Intemet Explarer EI@
U U ‘g, Ci\Users\User\Documents\B = | 3 | A ‘ |b Bing o ~|
i\f Favorites ﬁ;;; @ Suggested Sites v @] Web Slice Gallery »
"_’,é C\Users\User\Documents\Backu... & v B v =] mm v Pagev Safetyv Tools v @" ”
ASBP Backup Set as on 19 Jan 2010 05:53 PM
Backup Account: BACKUP ACCOUNT 01
Backup Group: A-5P OWMNER\RESELLER A\BACKUP ACCOUNTS
Storage Platform: 192.168.20.215
Backup Set Name: Default L
Backup Set Yersion: 6.0
Client Version: 6.0.0.685
Schedule

Daily backups for this backup set occur at 11h04

Mo advanced schedule is defined.

Selections

Overview
There iz 1 volume with selections:

.
o 1 folder directly induded
o 1 folder directly excluded
o 1 flle directly induded i

Gy v WIN% v
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It is recommended that you run a backup manually after creating your backup selection
to ensure immediate data transmission to the Storage Platform. Thereafter, automatic backups
will ensure hassle-free continuous backups. For more information,s ee fASchedul i
b a ¢ k Uates in this chapter.

To start a backup manually:

1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

Backup

The Backup dialog box appears and displays the progress of the backup:

-

|E| Backup @

| Preparing backup

Connecting ko service
Skarting backup
Initializing secure random generator., .,

2. To close the Backup Client after the backup process has started, click the Hide button.
This will not cancel the backup process and the Backup Client can be re-opened at any
time to view the progress of the backup.

You can monitor the backup progress at any time by right-clicking the system tray icon
and then clicking Monitor Progress
To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 7: Schedule Backup Process in Chapter 3 , i Account yo®en engble pnd b u t
schedule them at any point in time using the Options an d Settings dialog box.

Configuring automatic backups ensures that all selected data is backed up
automatically, without the need for any user interaction. This is a safer alternative to
relying on manual backups.

To schedule daily automatic backups:

1. On the Tools menu, click Options . Alternatively, click the Options button on the
toolbar.
In the Options and Settings  dialog box, click Backup Schedule
Select the Daily Automatic Backups check box, and then specify a backup time in
the Back up ev ery day at box.

4. Click OK.

To schedule advanced backups:

On the Tools menu, click Options .

In the Options and Settings  dialog box, click Backup Schedule

Select the Advanced Schedule  check box.

In the Week Day box, select a day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule  box.
Repeat steps 5 to 7 above until you have added all desired schedules to the Additional
Schedule box.

N ook

You are advised to back up at night when the machine running the Backup Client is
not in use. It must be switched on at the scheduled backup time(s), but the Windows user
does not need to be logged in.

Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup.

|E| Backup
| Sending backup

Zonnecting ko service

Starting backup

Initializing secure random generakar, .,

Connecking to Storage Platform on 192,168,20,215:443
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Tips:
To close the Backup Client after the backup process has started, click the Hide button.
This will not cancel the backup process and you can re-open the Backup Client at any
time to view the progress of the backup.
You can monitor the backup progress at any time by right-clicking the system tray icon
and then clicking Monitor Progress
To view backup logs, click the Logs tab. Backup log dates are displayed in blue.

| i Backup Selectiu:unl = | Eestnre| =| Logs
19 Jan 2010, 15:46:46 1346040 Tue, 19
19 Jan 2010, 15:44:22 essage: 15146145 05 Wini

19 Jan 2010, 15:38:45 | essage: 18:46:46 Using ba
essage: 15146046 Connect

Backups will be stored on the Storage Platform and accessible via the Restore tab. For more
i nformation on restoring data, see Chapter 6, fARest
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Cancelling a backup

Once a backup is in progress, you can cancel the process via the Backup progress window or
using the system tray icon.

To cancel a backup:

1. Perform one of the following actions:
a) Inthe Backup progress window, click the Cancel button.

IE' Backup @

| Sending backup |

Connecking ko service

Starking backup

Building selection list

Total selection: 570 bytes in 2 files and folders

Starking Y53 snapshat

Checking for differences

Total backup size: 171 bytes

Initializing secure random generator. ..

Connecting ko Skorage Platform on 192,165, 20,245 443
Server name: Skorage Plakfarm, AtkixS Dew 4,

| Server name: Storage Platform, Akkixs Dew QA |

[ Cancel *[ Hide: ]

b) Alternatively, you can right-click the runner icon in your system tray, and then click

Cancel .
Open
Backup Mow
Cancel Backup
r'~:'1n:|r'|itn:|rStatus[}s
Motifications k
About

2. In the confirmation dialog box that appears, click Yes.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successful and a
manual backup is initiated, the Backup Client will display the prompt: fiDo you want to
resume the failed backup ... ?0with a 30 second countdown.

s o

Canfirm resurme backup @

Do you want to resume the failed backup from Tue 19 Jan 2010, 18:51:507
(A new backup will stark in 28 seconds)

| Wes | | Mi | | Cancel

Click Yes to instruct the Backup Client to try to continue from where the process failed during
the previous backup. Click No to initiate a new backup or Cancel to return to the Backup Client
application window.

i) A new backup will be initiated automatically after the countdown has elapsed.
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On the Restore tab, you can browse a tree structure representation of all successful backups
and their files and folders.

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

On the Restore tab, the Restore tree gives you access to backed up files via two main nodes:
Last Backup and Previous Backups

: 2 Rost — The Last Backup node contains the file/folder
| " R e Saan | mestare Iﬁl structure of the last successful backup and displays

m the date and time it occurred in parenthesesfi (. ) 0
[ =I-4 - Last Backup (19 Jan 2010, 18:52:25]!|
el C .
i a i) Restores done from the Last
----- ° Workspace v .
Backup node are typically faster than

| =+ Frevious Backups | those done from the Previous Backups

o 19 Jan 2010, 11:44:27

19 Jan 2010, 11:43:08 backups from the Storage Platform and displays

-] 19 Jan 2010, 18:51:40 :

+:t 19 Jan 2|:|1|:|J LE:51:17 node as the Backup Client may be able to
- o ar. retrieve the data from the cache instead

#1419 Jan 2010, 18:46:16 the Storage Platform

#1419 Jan 2010, 18:38:15 :

#1419 Jan 2010, 17:40:25

+| 19 Jan 2010, 17:39:53 When you expand the Previous Backups  node,

o 19 1an 2010, 11:44:35 the Backup Client retrieves the list of previous

-

-

them in the tree.

To select and restore data from the

1. Click the Restore tab.
Expand the Last Backup node to view the files/folders.
Include a single file by clicking the T icon next to the file or by right-clicking the file
name and then clicking Include . Each included file is displayed with a green icon: .
4. Include an entire folder by right-clicking the folder and then clicking Include folder .
Each included folder is displayed with a green folder icon: L=,
5. If an entire folder is included but you wish to exclude a particular file or
subfolder, right-click the file or folder icon, and then click Exclud e or Exclude
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Folder . Excluded items are displayed with red icons: ® or . Included folders that
have some files or subfolders excluded are green with a red tint: £

Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options available, see fRestoringdatad | at er i n

To select and restore data from :

Click the Restore tab.

Expand the Previous Backups node to connect to the Storage Platform and retrieve a
list of all previous backup dates.

Expand the relevant backup node, and then click the folder/directory containing the
data.

Include a single file by clicking the ' icon next to the file or by right-clicking the file
name and then clicking Include . Each included file is displayed with a green icon:
Include an entire folder by right-clicking the folder and then clicking Include folder .
Each included folder is displayed with a green folder icon: L=,

If an entire folder is included but you wish to exclude a particular file or
subfolder, right-click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: ® or E¥. Included folders that
have some files or subfolders excluded are green with a red tint: £

Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For

information on t he r es Restormgdoaptta 0o.nbse laovvai | abl e,

t his

c ha

S

e
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After selecting the files and folders to restore, you can start the restore process as described

below.

To start the restore process:

1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
AN OYOR?
Backup Size Restare Find Cptions  Autornate  Help

The Restore dialog box will prompt you for a restore location:

Save files in:

1 Original location

@ Folder: |CiUsers\UseriRestore Browse

2. Select Original location  to restore the files to the same location that they were backed

up from or select Folder and then browse to a new location.

/v, | Warning:  If you select Original locatio n, the restored files will overwrite any
existing files with the same name in that location. A warning will, however, be

displayed before the Backup Client overwrites any files.

In the Options area, specify the restore options.

Options

Recreate directary structure
Restore empty Folders

[T] overwrite Files

[] Use compression {faster over the Internet)

For more information on restore options,

3. Click OK.

S

e e

t

h e
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Restore options

Recreate directory By default, the folder structure is recreated in the Restore
structure folder. To specify that all files be restored to one location, clear
the Recreate folder structure check box.

1/ Note: If restoring files from different folders with the
same file names, you need to recreate the folder
structure to prevent overwriting the files.

Restore empty folders To restore all empty folders within the directory structure, select
the Restore empty folders  check box. Clear the check box to
restore only those folders containing backed up files.

5/ Note: This option is only available when Recreate
directory structure is selected.

Overwrite files Select this option to prevent the Backup Client displaying a
prompt before overwriting existing files.
g’ﬁ Warning: If this check box is selected, files with

matching filenames in matching directories will be
overwritten without warning.

Use compression Select the Use compression check box to enable the Storage
Platform to compress files before transmitting them to the Backup
Client.
\;) Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will

reduce the size of the files, making the transfer
process faster.

i) | Note: You can view restore logs on the Logs tab. Restore log dates are displayed in
green.

I| ﬂ Backup Selection | ﬂ Restore g Logs
19 Jan 2010, 15:46:44 essage: 18146146 Tue, 19
19 Jan 2010, 18:44:22 essage: 13:46:46 05 Win
e Message: 15:46:46 Using ba

Message: 15:46:46 Conneck

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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To find a specific backed up file, it may be easier to use the Find function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and search through previous backups.

To search for a file in your latest backup:

1. On the File menu, click Find files in backups . Alternatively, click the Find button
on the toolbar:

L1990 e e e

Backup Size Restors Find Options  Autamate Help

2. In the Find Files in Backups dialog box, type the file name or part thereof in the File
name box, and then click Find .

File name (full or partial): sales|

@ Search last backup (local)

1 Search through previous backups {Storage Plakform)

Search backup dakes

[] Limit number of results ko: |10

Find

= If fealesois searched for, the Backup Client will display a list of all files in the
| ast backupsaksontf ai hhegfil ename.

Use the * and ? wildcards for advanced search queries.
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To search for a file in previous backups:
1. On the File menu, click Find files in backups . Alternatively, click the Find button

on the toolbar:
AN QIEEORON 2
Backup Size Restore Find Options  Automate Help

Type the file name or part thereof in the File name box.
Select the Search through previous backup s (Storage Platform)  check box.
4. If you wish to limit the search to particular dates, select the Search backup dates
check box and then use the Start date and End date boxes to specify a time period.
5. To limit the number of results that display, select the Limit number of results to
check box and then type a number in the box provided.
6. Click Find .

File name (full or partial): | sales

1 Search last backup {local)

@ Search through previous backups {Storage PlatForm)

Search backup dates

Start date: |01-01-2010 lEJ PR-dd-
End date: |01-19-2010 lEJ FM-dd-y

Lirnit numnber of resulks ko (10

Use the * and ? wildcards for advanced search queries.

i) If Search backup dates is selected, the backup date is used for the search
instead of the file create or file modified date.
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To restore files from the Find Files in Backup dialog box:

1. In the search results list, include the files to restore by clicking the icons next to the file

names or by right-clicking each file name and then clicking Include .

2. Click the Restore button.

File name (full ar partial); | sales

@ Search last backup (local)

1 Search through previous backups (Storage Platform)

Search backup dates

[ Limnit nurnber of results bo: |10

Search result

! | Falder | Filename |S | Date _|_Fi... _|_Ban:k... |
& Ch\Users\Bashier. .. saleshov2009,Ext OKB 19/01720... kxt 19/01/20...
©iCUsersiBashier... salesan2010.bxt  OKB 19/01j20... ket 19/01/20...
) ChUsers\Bashier. .. salesDec2009, bxt OKB 19/01720... kxt 19/01/20...

Resturﬁ

The Restore Options  dialog box will appear, enabling you to specify the location in which to save

the restored files. For more in
this chapter.

formation on

restore

C
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Restoring a backup selection

By default, with every backup performed, a copy of the backup selection is saved on the Storage
Platform. For more information on backup selection, see fiSelecting data to back upo earlier in

this chapter.

This enables you to restore, not only your backed up files and folders, but the selection you used

to back them up as well.

i) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire backup setup to perform exactly as it did at the last backup.

To restore a backup selection:

1. Click the Restore tab.
2. Expand the relevant backup folder, and then click the Workspace node.

| & Backup Selectiu:un| ol Restore | |=| Logs
ol Backups
=4~ Last Backup (19 Jan 2010, 19:12:50)

I S

\Waorkspace

[}~ Previous Backups

3. Inthe right-hand pane, click the icon next to backupset.xml entry.

Filenarne

& Include
& Exchd
1 Deselect

4. Click the Restore button on the toolbar.
5. Select the appropriate restore options. ( See @A Sel ecting data to resto

chapter.)
6. Click OK.

The backup selection will be restored to the location specified in the restore options.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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Atti x5 Pro allows Backup Administrators to
drive using the Hierarchical Storage Management (HSM) feature. Once data has been archived,
the backups will display in the Restore tree as greyed out folders, allowing you to browse the
file/folder structure of the backups. However, if you try to restore archived data, you may
receive a message informing you that the data has been archived to secondary storage, as
illustrated in the screenshot below.

il Backup Selection i Restors I 5] Lu:ugsl

i Backups Filenarme 5
|$|--l|__.. Last Backup (3 fug 2010, 12:50:

E“_ C ' booktmgr

(-4 Program Files  BOGTSECT.EAK
L WSS Writers  MEDOS.SYS

L workspace

=4 Previnus Backups

| 03 Aug 2010, 12:21:54

oL 23 2 2010, 15:56:25 I |

EH . 23 Jul 2010, 16:01:01 Iﬁl This data has been archived ko secondary storage

and removed From the Storage Platform, To restore any of these Files,
please contact your backup administrator and request
to have the Files moved back ko the Skorage PlatFarm.

[+ S5 Writers e
o] Workspace

i) Grey folders indicate archived data. However, if you do not see these folders in
the Restore tree, it does not mean that no archived backups are available. In such
cases, please consult your Backup Administrator for further details about archived
backups.

You can access archived data by requesting that your Backup Administrator import the HSM
data to the Storage Platform. Once the data has been imported, it will be available for restore in
the same manner as all other backups.

archi

vV e
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The Backup Client logs all backup and restore processes and their results in log files that you can
view on the Logs tab. The following sections describe how to access log files and modify their

settings.

The Logs tab in the Backup Client provides detailed information about each backup and
restore. An additional toolbar button appears when the Logs tab is opened: the Summary
button. Use the button to view only errors and warnings and the last 14 lines in the log file.

i

(] 2ittiS Pra w600

File Selection Tools Wiew Help

Backup Size

Restore

A% OO0 @00|=

Find

Cptions  Autormate Help Surnrnary

| & Backup Selection | = Bestu:urel =| Logs

£0 Jan 2010, 16:19%:11
Z0 Jan 2010, 16:05:24

Errors and warnings

Lask Few lines of log File

Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:

16:
16:
16
16:
16:
16:
16!
16:
16:
16:
16!
16:
16:
16:
16!
16:
16:

19183 - Technical Data -------------
19:23 Backup prepared in: 00:00:08

119123 Mew files: 8; 16,0 KB (comp: 0.0 KE)

19:23 Removed files: 0; 0.0 KB

19:23 Patched files: 1; 0.4 KE+ 0.3 KB = 1.0 KE
19:23 Skipped files: 0

19:23 Disk usage drive C: 31% Full, 12,56 GB[/39.
19:23 Cache using 445 bytes (< 1% of disk space
19:23 Temp dir using 2.0 KE (< 1% of disk space)
19:23 --mmmm e Data Transmitbed -----------
19:23 Mo Meed to kransmit: 0.0 KB

19:23 Transmitted during compression: 0

19:23 Transmitted after compression: 1.5 KB in 22
19:23 ========== Backup Summary =====
19:23 Total seleckion: 0.0 KB in & files and Folders
19:23 Total backup time: 125

19:23 Backup Skatus: Successful
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You can specify your logging preferences on the Logging page in the Options and Settings
dialog box.

Modifiable settings include:
level of detail included
date inclusion/exclusion in time stamp
log file retention period

For information on configuring the log file settings, see Loggingi n Chapter 8, AiOpti on
settings. o
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To access the Options and Settings dialog box:

On the Tools menu, click Options
Alternatively, click the Options button on the toolbar:

Backup Size

Restare Find Qptions | Autornate

°© 5O 00o e

Help

The various options and settings are grouped in the left-hand pane according to their functions.
Click an item on the left to view the full set of options related to that function.

< Click Advanced Options

on the right:

in the left-hand pane to view all advanced options

Options and Settings

0 Account and Security
Connections

Advanced Dptions

()

Backup Schedule

Display

Disk Usage
Performance and Limits
Logging

 Advanced Options

YOO DD

Backup Throttle

Communications

Always connect to the Storage Platform during the backup process.
Mate: Enable this option to always update the Starage Platform with the last backup date, even

if there were no changes ko the backup selection.

[ Use secure (S5L-enabled) connection for data transfer {Recommended),
‘Warning: This should only be disabled to enhance transfer speeds after the network has been

confirmed to be secure.

Backup Process

Enable Yolume Shadow Copying (YS5) to back up locked Files.

Retries and Timeouts

Mumber of BackupfRestore attempts before cancelling: :I 04
Duration between connection retries (seconds): :I &0

Socket timeout {seconds): :I &0

ok

H Cancel ][ Help

Warning:  The Options and Settings

dialog box controls advanced features in the
Backup Client. Please read through this section carefully before changing any settings.
Incorrect settings could cause critical errors.



You can use the Account and Security page in the Options and Settings
Update Account information

dialog box to:

Change your password, encryption key or Backup Account properties

Modify Client security settings

ATTIX’

Options and Settings

0 Account and Security
Connections

Account and Security

Performance and Limits Storags Platform:

) Logging Your current account limit is:

Advanced Options
Click on Retrieve Settings to connect to the
Storage PlatForm and retrieve the account settings.

Account Setup

) Backup Schedule Account Information

1 Backup Throttle

) Display Backup Account: BACKUP ACCOUNT 01
) Disk Usage Backup Group: A-5P OWYNMERIRESELLER. AVBACKUP ACCCOUNTS

192.166.20.215
512 MB

Retrieve Setkings

From this section, vou can change your password or encryption key and run the Setup Wizard,
should you want to create a new account or reconnect o an existing one,

Change Password ] l Change Encryption Key ] l Run Setup Wizard

Security Settings

or restore procedures,

@ Remember password for backup and restore
() Prompt For password an restore

_ Prampt For password ko open the Backup Client and to resto
= wou will have to reinstall the client)

Specify whether the Backup Client should remember the Backup Account password during the backup

re. (If vou Forget the passwaord

Ok ” Cancel H Help
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The Account and Security page consists of the following areas:
Account Information area
Account Setup area
Security Settings area

This area displays your Backup Account information as it is configured on the Storage Platform.
You can use the Retrieve Settings  button to update your Account settings.

This button is useful to verify that the Account limit has been modified after
requesting a change from the Backup Administrator or to update Backup Group
Profiling settings.

You can use the Change Password and Change Encryption Key  buttons to overwrite the
current password and encryption key. To change your Backup Account settings, click the Run
Setup Wizard button. For more information, see Account Setup Wizard in Chapter 3,
fifAccount setup. O

v | Warning:

Changing the encryption key involves intensive processing on the Storage
Platform and may take several minutes. You should avoid doing this unless the
encryption key has been compromised.

Disaster recovery is not possible without the encryption key. Please ensure that
this key is kept in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON
THE STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF
LOST.

In the Security Settings area, you can select whether or not the Backup Client should remember
the Backup Account password when running a backup or a restore.

There are three options available:

Remember password for backup and restore : The Backup Client remembers the
Backup Account password when doing a backup or restore. This is the default setting.
Prompt for password on restore : The Backup Client prompts for the Backup
Account password during the restore process.

Prompt for password to open the Backup Client and to restore : The Backup
Client prompts for the Backup Account password when opening the Backup Client and
the Restore tab.



Connections
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You can use the Connections page in the Options and Settings  dialog box to:
Modify Storage Platform connection settings

Enable/disable/configure proxy server details

r

Options and Settings

Account and Security

" Connections

S

Connections

r=

Backup Schedule
Backup Throttle

Display

Disk Usage
Performance and Limits
Logging

YOO O OO

Advanced Options

Connection Settings

|Jse this section ko change vour connection settings, These settings were configured in the Setup
wizard during the installation process,

(@) Use network conneckion
() Use dial-up connection

Dial-up Settings. ..

Proxy Server

If vou use & proxy server For your Internet connection, you will probably have to supply the same
proxy server infarmation in the Backup Client,

@ Mo procy

() Use HTTP praoxy

() Use SOCKSWS Provcy

Proxy Hosk: Procey Pork: (10050

Proocy server requires authentication

Username:

Password:

Ok ” Cancel H Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Connections page consists of the following areas:
Connection Settings area
Proxy Server area

In this area, you can change the type of connection that the Backup Client uses to connect to the
Storage Platform. You can choose between a network or dial-up connection.

i) The Dial -up Settings button is enabled if you select Use dial -up connection
Click this button to select an existing dial-up connection configured on the computer and
then supply the username and password for that Internet connection.

In this area, you can specify whether or not the Backup Client should connect to a proxy server
when connecting to the Internet. If you select that it should, you can specify the proxy server
details in the relevant boxes.



Backup Schedule
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You can use the Backup Schedule page in the Options and Settings  dialog box to:
Enable/disable daily automatic backups

Create advanced automatic backup schedules

Configure Backup Client reactions to skipped backups

Options and Settings

Account and Security
Connections

Backup Schedule

- Backup Schedule
Backup Throttle

Display

Disk Usage
Performance and Limits
Logging

AN ODDDMEO O

Advanced Options

Automatic Backups

Daily automatic backups

Back up every dav at: :l 19h 00 @

[ Advanced Schedule
Back up at the Following times

Week Day

Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday

Skipped Backups

Display a warning after skipped backups: jWarn after 4 davs when online -

Backup kime:

= 1zhoo

#dd

Delete

Additional Schedule

&

Ok ” Cancel H Help
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The Backup Schedule page consists of the following areas:

Automatic Backups area
Skipped Backups area

In this area, you can enable or disable automatic backups.

Daily automatic backups are enabled by default unless disabled during the
Client installation. If disabled, you can enable it by following the instructions
below.

To enable automatic backups:

1.
2.

3.

Select the Daily automatic backups and Advanced Schedule check boxes..
Specify a time in the Backup every day at  box
Click Ok.

To disable automatic backups (not recommended):

1.
2.

Clear the Daily automatic backups check box.
Click Ok to close the Options and Settings dialog box.

Warning:  This option is not recommended. If an automated backup schedule is not
created, backups will have to be run manually. Enabling automatic backups is
strongly advised.

For detailed instructions on how to enable and schedule automatic backups, see Scheduling
automatic backupsi n Chapter 5, fABackups. o

In this area, you can specify what action the Backup Client should take in the event of skipped

backups.

The following options are available:

Do not display a warning
Warn after 4 days when online
Warn immediately when online



Backup Throttle

The Backup Throttle page in the Options and Settings

ATTIX’

dialog box enables you to specify the

Client's bandwidth usage speed limits. You can do this by creating a backup throttle schedule.

Backed up data will then only be transferred at the specified speed limits during each interval.

Options and Settings

1 Account and Security
) Connections

Backup Throttle

) Backup Schedule
" Backup Throttle

D

Display

" Disk, Usage
Performance and Limits
Logging

MO

o Advanced Options

Speed Limits

Specify one or more speed limits (in kilobytes per second) that can be used when sending backup data
to the server. A limit of 0 indicates that no limit will be applied.

.Limitl: o= kejs .LimitZ: ol ks
B it = o0 keis [ it 4: ol keys
Lirit 5 0t keis [ umice: ol keys
Thrattle Map
) ]l Selected speed limit:
Inkesval: 60 5| minukes {Click t cycle)
1 3 7 9 11 13 15 17 19 21 23
MMonday
Tuesday
Wednesday
Thursday
Saturday
Sunday
l Clear ” Defaulk
ik ] [ Cancel ] [ Help
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The Backup Throttle page consists of the following areas:
Speed Limits area
Throttle Map area

In this area, you can specify one or more speed limits (in kilobytes per second) that can be
applied when sending backup data to the Storage Platform.

To specify a speed limit:
Choose a colour to represent the limit and specify the limitint h at cloniitohox. 6 s
You can now schedule the speed limits in the Throttle Map area as described below.

i) A limit of O indicates that no limit will be applied.

In this area, you can indicate when the speed limits specified in the Speed Limits area should
apply by creating a throttle map.

By default, a throttle map is provided with different colours indicating week day
office hours, out-of-office hours and weekends (using intervals of 60 minutes). You can
either set speed limits for the colours used in this default map or you can click
the Clear button and create a new map by following the instructions below.

To create a throttle map:
1. IntheInterval box, specify the number of minutes that each block in the graph should
represent.
In the Speed Limits area, click a speed limit colour.
In the Throttle Map area, click the schedule interval boxes you wish to apply the limit to.
The colour of the selected interval boxes will change to match that of the chosen limit.



Display
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You can use the Display page in the Options and Settings  dialog box to select your Backup

Client display preferences.

P

Options and Settings

Account and Security
Connections

S

Backup Schedule
Backup Throttle

© Display

Disk Usage
Performance and Limits

Logging

sllalalal [afalla]

Advanced Options

Selection Table

[ Display File Type column in seleckion table.

Display folders in selection table,

Ok ” Cancel H Help
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The Display page consists of a Selection area that provides you with the following options:

Display File Type column in selection table - Adds a File Type column to the
right-hand pane.
Display folders in selection table - Enables the right-hand page on the Backup

Selection tab to display subfolders.



You can use the Disk Usage page in the Options and Settings  dialog box to:

Move the working folders and cache to a different location
Specify the number of days that files are to be kept in the cache

ATTIX’

Options and Settings

~

Account and Security

5

Disk Usage

Advanced Options

) Connections

) Backup Schedule wWarking Falders

" Backup Throttle

1 Display ¥ou can move the Cache, Log, Temporary Folders and the Selection Database to another location if
" Disk Usage there is limited space available on the drive where the Backup Client is installed.

" Performance and Limits Moke: Ahways keep these folders on the same drivevolume,

) Logging

=

Temp: C:\Program Files\attixS ProlBackup Client DL\koBackup Browse. ..
Cache; CA\Program FileshAttixS ProtBackup Client Dlicache Browse, .,

Logs: C:\Program Files\attixS PralBackup Client DLYlogs Browse. ..

Database: |C:\Program Files\AttixS ProlBackup Client DL Browse, ..

Cache

Changed files are compared to the previous version ko anly transmit patches. The longer files are
kept in the cache, the better the chance of transmitting patches instead of Full copies.

Davs ko keep files in Cache: :l 20 Clear Cache. .,

ik ][ Cancel ][ Help
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The Disk Usage page consists of the following areas:
Working Folders area
Cache area

If you have limited space on the drive running the Backup Client, you can move
the Cache, Logs and Temporary folders as well as the selection database to another location.

The following locations are configurable in this area:
Temp - Used as temporary workspace when the files are patched, compressed and
encrypted.
Cache - Keeps a local, compressed and encrypted, copy of the selected files for a
specified number of days.
Logs - Stores all backup and restore logs.
Database - Compares the latest backup selection with the previous backup to
determine the changes.
1. | Warning:
The Cache and Temp folders must reside on the same drive/volume.
If the database or any of the folders are stored on a network share, please

ensure that the Backup Service has the correct permissions to connect and write
to that share.

When modifications are made to a file, the Backup Client only transmits changes to that file, as
opposed to transmitting the complete file again. This is accomplished by the use of a local cache.

By default, recently modified files are kept in the Cache for 20 days, after which they will be
deleted. Once a file has been flushed from the cache, a full copy will be backed up when any
modifications are made to the file. The longer files are kept in the Cache, the better the chance of
only transmitting patches instead of full copies and thus reducing the amount of data that needs
to be transmitted. If there is limited disk space available, consider shortening the time files are
kept in the cache.

i) If you specify 0 days for caching, patching is disabled. All files in the Cache will
be deleted, and full copies of changed files will be transmitted to the Storage Platform
during each backup.

To delete the current cache, use the Clear Cache button. If the cache is deleted, full copies of
the selected files will be re-sent to the Storage Platform during the next backup.

i) The Backup Client will log the message Doing monthly cache cleanup once a
month. This maintenance task is to ensure that there are no redundant files in the Cache.
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You can use the Performance and Limits page in the Options and Settings  dialog box to:

Enable/disable the Run backups in the backgrou

ATTIX’

nd option (Windows 7 and Vista)

or increase/decrease Backup Client processor and disk usage (Windows XP and 2000)

Restrict backup size

Options and Settings

5

Advanced Options

C 'ﬁ'cmunt_and Zecurity Performance and Limits

) Connections

) Backup Schedule Processor Usage & Disk Access

1 Backup Throttle

1 Display If vwou experience any performance deterioration during the backup process, wou can lessen this
) Disk Usage effect by choosing ko run the backup in the background, which lowers the disk and CPU usage
" Performance and Limits priarity in Windows.

) Logging

=

[7] run backups in the background

Lirnits

This section allows you ko manipulate the data transfer during the backup process if vou have ko limit
the transfer in any way.

[] Restrict size of each backup (MBE]: :‘ 10

Cycle backup process until all selected data has been transferred. The backup process
will be repeated until the complete backup has been transferred ko the Storage PlakForm,

Ok ” Cancel H Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Performance and Limits page consists of the following areas:
Processor Usage & Disk Access area
Limits area

The Backup Client uses a fair portion of available processor power to patch, compress and
encrypt files during the backup process. If you use the computer at the same time, you may
experience some performance deterioration. To lessen this effect, you can choose to run backups
in the background on Windows 7 machines or lower the processor usage and/or disk access on
Windows XP machines.

Windows 7 and Vista

On Windows 7 and Windows Vista machines, a Run backups in the backgr ~ ound check box
enables you to instruct the Client to run all backups in the background, thereby lowering the
disk and CPU usage priority in Windows and allowing other applications to run faster.

i) The Run backups in the background check box is deselected by default.

Windows XP and 2000

On Windows XP and Windows 2000 machines, two sliders enable you to adjust the processor
usage and disk access settings to limit performance deterioration.

Processar Usage: | J
Lo High
Disk. Access: |_J
Loy High
1, | Warning:  If you use the highest Processor Usage setting, it will affect machine

performance during the backup.

i) If you use the High Disk Access setting, the Backup Client will continuously use

| all available disk access to read and write to the disk, ensuring that the process
completes as quickly as possible. The process will take longer if this setting is lowered
but other disk-intensive applications will perform better.
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Select the Restrict size of each backup (MB) check box and specify a maximum value to
limit the total amount of data that may be transmitted to the Storage Platform during each
backup.

If this option is enabled, it may take several backups before all files are
transmitted to the Storage Platform. This feature is especially useful when using a slow
Internet connection and there are problems with transmitting large backups.

Cycle backup process... 1 You can use this setting in conjunction with the backup size
restriction to cycle backups successively until all data included in the backup selection has been
transmitted to the Storage Platform. This setting is only available if a backup size restriction has
been specified.
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Logging

You can use the Logging page in the Options and Settings
preferences.

Modifiable logging settings include:
Level of detail included
Date inclusion/exclusion in time stamp

dialog box to specify your logging

Application log location and debug inclusion/exclusion

Log file retention period

Options and Settings

1 Account and Security

S

) Connections
1 Backup Scheduls Backup and Restore Logs
1 Backup Throttle
1 Display
files.
) Disk Usage e : .
) Parformance and Limits Lewel of Detail: Al information |
 Logging [ 1nchude date in log file time stamp.
-

Advanced Options

Application Log

Log File: backupservice log

[7] Log debug messages

Automatic Log File Deletion

[T Delete log files older than (days): i‘ 30

‘fou can specify the amount of detail and the content that should appear in the backup and restare log

¥ou can specify that old log files be deleted after a certain amount of dayws,

Browse. ..

Delete Clder Logs Mo

” Cancel H Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved.
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The Logging page in the Options and Settings  dialog box consists of the following areas:
Backup and Restore Logs
Application Log
Automatic Log File Deletion

In this area, you can specify the level of information to be included in the log files by selecting
one of the options provided:

All information (logs all messages)

Suppress detail

Log warnings and errors (logs only warnings and errors)

Select the Include date in log file time stamp check box to add the date to every line in each
log file.

In this area, you can specify where the Backup Client's application log file should be saved and
whether or not debug messages should be logged.

In this area, you can enable a log file retention period by specifying that the Backup Client delete
files older than a particular number of days. To do this, select the Delete log files older
than check box, and then specify the number of days in the box provided.

To delete all logs older than the specified humber of days immediately, click the
Delete Older Logs Now  button.
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Advanced Options

You can use the Advanced Options page in the Options and Settings
the following Backup Client options:

Storage Platform communication

Backup process

Retries and timeouts

dialog box to configure

-

Options and Settings

Account and Security

S

Advanced Options

‘Warning: This should only be disabled to enhance transfer speeds after the netwark has been

confirmed to be secure.

Backup Process

Enable wolume shadow Copying (w333 to back up locked files,

Retries and Timeouts

Murber of BackupfRestore atterpts befare cancelling: il 04
Duration between connection retries (seconds): il )

Socket timeout {seconds): il )

) Connections

1 Backup Schedule Comrmunications

1 Backup Throttle

() Display Always connect ko the Storage Platform during the backup process.

) Disk Usage Moke: Enable this option to always update the Storage PlatForm with the last backup date, even
" Performance and Limits if there were no changes to the backup selection,

; I.;.Ddi?e::ge o 6 i [ Use secure (55L-enabled) connection For data transfer (Recommended),

Ok

” Cancel H Help
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The Advanced Options page in the Options and Settings  dialog box consists of the following
areas:

Communications area

Backup Process area

Retries and Timeouts area

Always connect to the Storage Platform during the backup process

When the Always connect to the Storage Platform ... check box is selected, the Backup
Client will connect to the Storage Platform during each backup, whether or not changes were
made. This updates the Last Backup date stamp, even if there were no changes made to the
backup set, ensuring that the Storage Platform always reflects the latest backup date.

Use secure (SSL -enabled) connection for data transfer

This option is selected by default, enabling SSL encryption for Client-to-StorageServer data
transfers. Deselecting this option disables SSL encryption for data transfer. This enhances
transfer speeds but should only be done within a secure network environment.

Disabling this feature will only have an effect on security for the actual data
transfer and not the encryption of the data on the Storage Platform.

Secure data transfer connections can only be disabled if the StorageServer has
been configured to accept non-secure connections. If the StorageServer cannot
accept non-secure connections, an SSL-enabled connection will automatically be
used instead.

t. | Warning : If you wish to disable SSL encryption, please ensure that the backup
environment is secure.

Enable Volume Shadow Copying to back up locked files

Microsoft Volume Shadow Copy Service (VSS) provides a solution by creating a snapshot of data
at any given point in time without any interruption to any applications. Using this option
enables the backup of open or locked files.

/v | Warning : Please use relevant plug-ins to back up databases.

Number of Backup/Restore attempts before cancelling

By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. You are advised to increase the number of attempts when using a
slow Internet connection. The backup will continue from the previous point of failure and not
resend the entire backup.
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Duration between ¢ onnection retries
By default, if the connection is dropped, the Backup Client will try to reconnect to the Storage
Platform after 60 seconds. This setting enables you to increase/decrease the duration between

the retries.

Socket timeout
If the Backup Client is connected to the Storage Platform and there is no communication

between the two, the time specified in this box (in seconds) is how long the Backup Client will
stay connected before dropping the connection. The default socket timeout is 60 seconds.
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DL includes tools that allow advanced users to modify, enhance and streamline the Backup
Client.

Remote Management enables the Backup Administrator to remotely access and configure the
Backup Client using the Storage Platform Console.

To enable Remote Management:

1. Onthe Tools menu, click Remote Management

2. In the Remote Management  Settings dialog box that appears, select the Enable
Remote Management  check box.

3. In the Connection area, ensure that the port number in the Port box is correct (9091 is
specified by default). If incorrect, modify as required.

4. If the machine has multiple IP addresses available, you can specify whether the Remote
Service must bind to all available IP addresses or to only one IP address.

5. Inthe Access area, select the access credentials to be allowed.

D

' Allow SP controlled access enables Backup Administrators with the
correct access permissions to use their Storage Platform User Access
Management usernames and passwords to connect to and administer this
Backup Client. If you clear this check box, Storage Platform administrators
will not have remote access.
Select Allow custom access and supply a username and password if
you do not wish to make use of the above-mentioned Storage Platform
Access Accounts. These custom access credentials must be specified in the
Storage Platform Console for its user to gain remote access.

6. Click OK to save the settings. Services will restart automatically to apply the settings.
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The Backup Client Health Check provides information to highlight possible issues before backup
(e.g. free disk space or file/folder access problems). It can also provide the estimated line speed

to the Storage Platform.

-

[Ea] Health Check ==

The Health Check provides information to pre-emptively highlight possible issues, For example
free disk space problems and service access rights to files and Folders, Ik can also provide the
estimated line speed to the Storage Plakfarm,

Options

-

Mermory utilisation skatistics From the last backop as well as overall memory usage to date.

| Daka Prokected
Information includes the number of files and directories selected For backup,

| Disk Usage

Free space availability For all local drives,

| Line Speed
Line Speed estimate to the Storage Platform by transmitting data for 10 seconds,

| Service Rights
Information about the service account name and access rights to the working Folders,

| Shiow Last Health Check. | | Skart | | Close

The following options are available:

Memory - Memory utilisation statistics from the last backup as well as overall memory
usage to date.

Data Protected - Information includes the number of files and directories included in
the backup selection.

Disk Usage - Free space availability for all local drives.

Line Speed - Line Speed estimate to the Storage Platform (determined by transmitting
data for 10 seconds).

Service Rights - Information about the service account name and access rights to the
working folders.
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You can specify which checks to run by selecting or clearing the relevant check boxes in the

Options area. Use the Show Last Health Check
can Print and/or Export the Health Check reports.

To run a health check:

1. Onthe Tools menu, click Health Check

button to see the last report. You

2. Inthe Health Check dialog box that appears, specify which checks to run by selecting

or clearing the check boxes next to the options. Five checks are available (see above).

3. Click the Start button to begin the health check process. The Health Check dialog box

appears, displaying the progress of the health check until completion.

y.

[Ea] Health Check
| Completed

=]

TITTICRANET 1 SCCOn & 1l IO O ST o, .

Server name: Storage Platform, AtkixS Dey Of
User authenticated

Block size sent: 2,045 bytes

Bwtes senk: 114,90 ME

Total time: 10000ms

Connection speed estimate: 11,49 MEs
Checking service rights

Service display name: AtkixS Pro

Service shark name: ASBackup Service

Service running under account name: LocalSyskem

‘\aSbackup.exe" -skart

Checking write access permissions For service
Cache directory: writeable

Temp directory: writeable

Database direckory: writeable

Logs directory: writeable

Health check complete

Connecting ko Storage Platform on 192,168,20,215:443

Service installed ak: "C\Program Files!AkkixS ProiBackup Client

m

-

4. When the message: mpikda®lot i e aky sco cl i ck
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The Health Check results display in a new dialog box with options to print, export to HTML and
export to CSV.

|E| Health Check Fesults @

Examine the health check resulks below and print or export the report as needed,

Health Check Results

Healthcheck start
tirme:

m

Wed lan 20 16:49:48 CAT 2010

Healthcheck end
tirme:

Healthcheck
duration:

Wed lan 20 15:530:00 CAT 2010

12s

Memory

Memory stats last backup

Lowest free: 3.56 MB
Highest total 37 48 MB
Mermory;

Maximurm memory 554 06 MB

setting:

Close

Print | | ExporthoHTML | | Exporttocsy |
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The Backup Snapshot feature enables you to create a backup of all items included in your
backup selection and send it to a disk drive. This Snapshot data can then be moved to the
Storage Platform.

You can use this feature to reduce the initial backup window if there is a large amount of data to

be transferred, typically over a slow Internet/network connection. A similar procedure enables

you to restore a large amount of data (e.g. during a disaster recovery).

Warning s:
A This procedure should only be performed with the assistance of the Backup
Administrator.
A Ensure that you have an active Backup Account.
A Before beginning the Backup Snapshot process, it is best to perform a test backup,
transferring only a small amount of data, to ensure that the StorageServer
connection is successful.

To export a Backup Snapshot:

1.
2.

3.

On the Tools menu, point to Snapshot , and then click Export Backup Snapshot
Select The next backup must be a Snapshot backup

Specify a destination in the box provided (C:\Backups \Export \ Snapshot -Backup
is specified by default on Windows 7 machines.)

Click OK.

Initiate a backup.

The Snapshot data is now stored in the location specified in step 3 above and can be moved to

the Storage Platform. The Backup Administrator can then import the snapshot data to the

StorageServer using the Storage Platform Console. (For more information, please refer to the

Storage Platform Console User Manual.)

The Backup Account will be disabled at this point to ensure that the Snapshot
data is the most recent. Once the data has been successfully imported to the Storage
Platform, the Account will be enabled automatically and backups can proceed as usual.
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The Restore Snapshot feature enables you to restore large amounts of data from a locally
connected device to a machine via the Backup Client.

i) Before you can perform the steps outlined below, the snapshot data needs to be
exported from the StorageServer to a mobile storage device by a Backup Administrator.
For more information, please refer to the Storage Platform Console User Manual.

To restore data from a Snapshot:
1. Connect the mobile storage device containing the snapshot data to the Client machine
or to a Local Area Network so that it has access to the Client machine.
2. Onthe Tools menu, point to Snapshot , and then click Import Restore Snapshot
3. Select whether you wish to restore the data from a disk drive or recovery server.
a. If restoring from disk, select the Show Restore Snapshot(s) in Restore

panel check box and then specify the path to the data in the Snapshot
location box.

1. | Warning: The  default  snapshot location specified is:
C:\Backups\Import\Snapshot-Restore. If you wish to use this location,
you need to create the folder structure on the machine and then paste the
snapshot data onto the Snapshot -Restore folder. This folder is not
created automatically. Alternatively, you can use the Browse button to
browse to the location in which you have saved the shapshot data.

i) You need to specifyt he snapshot dat AO@Tstheg
snapshot folder itself. (E.g. If your snapshot data folder is called
20100506124347 and youbve pasted it to
specify C:\Users \ Administrator ~ \ Desktop in the Snapshot location
box, NOT C:\Users \ Administrator ~ \Desktop \20100506124347 .)

b. If restoring from a recovery server, select the Do restores from recovery
server check box and then specify the server address and port number in the
boxes provided. If using a proxy server, select the Use proxy settings for
recovery check box.

i) This option can only be used if the Backup Administrator has
prepared a recovery server.
4. Click OK.

The Snapshot data will display as an entry in the Restore tree, enabling you to browse a
directory of its contents and restore files and folders. For more information, see Chapter 6,
fRestores. o
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You can use the command-line interface (CLI) to run the Setup Wizard remotely, enable Remote
Management and send a wide range of backup and restore commands to any Backup Client
connected to a LAN. For more information, please contact your Backup Administrator.
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Profiling enables your Backup Administrator to propagate certain client-side settings from the
Storage Platform to your Backup Client.

It can be used to enforce the following settings:
Backup schedules
Inclusions and exclusions
Filters
Most options and settings accessible via the Tools menu

i) Profiled settings take priority over settings specified in the Backup Client.

| When the Backup Client connects to the Storage Platform, it receives a list of all profiled
settings. These changes are implemented in the Backup Client. You can, however,
connect to the Storage Platform and update profiled settings manually.

To update profiled settings manually:

1. Onthe Tools menu, click Options .
2. On the Account and Security  page of the Options and Settings  dialog box, click
the Retrieve Settings  button.

The Backup Client will retrieve any profiled settings from the Storage Platform and update its
options and settings accordingly.

i) Profiled settings are greyed out, and cannot be modified from within the Backup
Client.

Inclusions/exclusions applied by profiling are displayed with yellow icons in the Backup Client:

File icons:
Included file

¥ File included by filter
Excluded file

Folder icons:
Included folder

¥ Folder included by filter
£ Excluded folder
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Keyboard shortcuts and hotkeys

_

F5 Refresh active window

SPACEBAR x2 Exclude selected file/folder

SHIFT+ g /C Select multiple files
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